


JOURNAL 3.0

Copyright 1992,1993 HandyWare
Overview
Introduction
Overview and Important Information
Quick Help
Main Program
Configure Categories
Search Form
Preferences
Clipboard Form
Quick Start Tutorial

How to Register Journal

Commands
Menu Commands
Toolbar
JourClp Button
Rearrange Topics
Keyboard Shortcuts
How to ...
Questions and Answers
About
Author
Shareware
ASP




Introduction

Journal provides a handy way to store the text data which you acquire on a dialy basis.
Getting the data into Journal is easy with four ways to store the data within Journal:

(1) Enter the data directly from the keyboard

(2) Grab the data currently on the Clipboard

(3) Read a text file directly into journal

(4) Import a delimited text file.

The reason you would use Journal is that the various forms of text data that crosses
your desk on a daily basis can easily be gathered and grouped together into a logical storage
system and later easily and quickly retrieved using powerful search features. If you store all of
your text data in Journal then you only have to go to one location to then quickly retrieve the
data. In this sense, Journal is like an electronic file cabinet. The big difference, however, is
that Journal incorporates powerful search techniques including a hypertext-like topic jump
capability.

Journal information is first grouped into categories. You can have eight categories
active at any one time. Within each category you can store up to 400 different topics. Each
topic can hold 32K of text. The topic titles are displayed in a listbox at the left and the
corresponding text is displayed in a textbox. New topics can be selected by clicking on its title
in the topic titles list box.

Searching includes that capability to search for any word or phrase appearing in any
topic title, anywhere within the text of the currently selected category or anywhere in the text of
all categories loaded. After doing a search a list of the topic titles of all topics satisfying the
search pops up. A single click on a title takes you to that topic. If you are viewing a topic,
double click any word or select any phrase, press the F7 key, and the search is conducted for
that word or phrase throughout the text of the current category. For more info on searching ...

JourClp When you first start Journal, this button will

[oac be located in the upper left corner of the
screen. this button can be relocated to any
convenient place and Journal will remember
where you want it. The button is used to
grab text off the Clipboard. When you click
the button, Journal grabs the text on the
Clipboard and opens a form for you to decide
whether to place it as a new topic or append
it to an existing topic. For more info ..

How to ... Click on the How to to find our more
informaton about a lot of different things that
you can do within Journal.

Overview & Important Information

Journal runs best with at least 2 MB, better with 4 MB. Program speed performance is
best sutied to a 386, 20 MHZ machine or better. An important speed consideration is the speed



of the hard disk since each topic text is read and written to the disk each time a new topic is
selected.

Category information is stored in four separate files. If you want to copy a category to
another computer all four files are required. The DOS filename is the category name and the
extension of the four files is: ISD, ISF, ISM and LST. For example, the files for Dailyjou would
be:

DAILYJOU.ISD, DAILYJOU.ISF, DAILYJOU.ISM, DAILYJOU.LST

The JOURNAL.INI file holds specific information on the configuration of Journal. It also
holds the names of the categories that were active the last time Journal was run. Therefore,
none of these caegories should be deleted.

Active and Loaded:

The meanings of a category being ACTIVE and LOADED are important to understand.
Active means the category is assigned to one of the eight category buttons, the category name
appears as the caption. It can be loaded by simply clicking the button.

When a category is Loaded, it's caption is in all red, capital letters and it is within the
search path for both Titles search and if you choose to search the text of all loaded categories.

Categories are made Active by adding them using the Configure Categories Menu
selection They are removed using the same menu selection. Categories are loaded by simply
clicking their button. To unload a category, use the Configure Categories option. A shortcut to
get to the Configure Categories screen is to , click on a "blank" category button or by clicking
the RIGHT mouse key over any category button

Program Capacities

Categories: 8 active at any one time. The first is DailyJou (it may be renamed) and is the
opening default category. The other seven are configured by the user.

Topics: 400 per category

Topic text: Maximum of 32K per topic



Main Program Quick Help

Click on the picture for Quick Help
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Configure Categories

Click on the picture for Quick Help
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Search
Click on the picture for Quick Help

Journal Search
Search For: the

[ Case Senszitive Search 2

1 193703726 Fri Daily Hotes Titlez Search
1 293/03/26 First Test Record

~ Text Search—

[ Search Al

Done




Preferences
Click on the picture for Quick Help
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Clipboard

Form for adding or appending Clipboard text:

Click on the picture for Quick Help
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Import Data File
Form for importing a file to the current category

Click on the picture for Quick Help
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Quick Start Tutorial

To best use this tutorial, set up the Windows desktop so you can quickly switch between
this Help file and the Journal Program; keep both open.

You can move through this tutorial, page by page, using the Help Browse buttons. (The
Help browse buttons are the two on the right hand side of the third line, one is labeled >> and
the other <<.)

Getting Started

Category Buttons

Adding New Topics

Read Text File into Topic

Add new Topics from the Clipboard
Append to Topic from the Clipboard
Editing Topic Titles

Find - Titles Search

Find - Text Search

Transfer Topics

Rearrange Topics
Some Additional Goodies




Getting Started

Before starting the tutorial, we need to ensure Journal is launching correctly. In order
for Journal to be able to find its files, a Startup Directory MUST be specified and must be the
directory where you intend to store your Journal data files.

For example, if you intend to use C:\Journal:

and you are running from Program Manager as your shell, go back to the
Program Manager, highlite the Journal icon, click the File Menu, select properties, and make
sure the Startup directory is specified as C:\Journal (or whereever you put Journal).

or If you are using Norton Desktop, the Startup Directory is specified as part of
the Options on the Properites Dialog box.

If another Shell is being used, in order to run Journal correctly, you must be able
to specify a Startup directory. If the Startup Directory was not correctly specified, then make
the required corrections (specify the correct startup directory) and restart Journal.

Active and Loaded

These are a couple of terms with which you must be familiar. It's really no big deal, but
you will better understand how the program works if you are familiar with the terms.

A category is either Active or it is Removed. If it is Active then it is assigned to one of
the category buttons. It's name will appear as a caption on that button. To make a cateogry
active, use the Configure Categories Menu selection (shortcut: click a "blank" category or
RIGHT mouse click any category button) and either add an existing category to a button or
create a new category. Since this can be done so quickly and easily, you are virtually unlimited
in the number of categories you can have; you can just have 8 active at any one time. To
Remove a category, you also use the Configure Categories Menu Selection.

Once Active, a category is loaded by simply clicking it's button. It will then stay loaded
unless you use the Configure Categories Menu selection to Unload a category. When a
category is loaded, it's caption will be in all red, uppercase letters. The importance of whether
a category is loaded or not really applies to conducting searches of the data; namely searches
are done only in the loaded categories. Even more important, if you are going to search within
the text of all loaded categories, then obviously the more loaded and the larger the categories,
the longer the search time. That's the sole reason for the loaded versus unloaded capability.

Remember the shortcut to bringing up the Configure Screen is to Right mouse click any
category button.



Category Buttons

Click here to look at the main form layout. After reviewing the main form, select the
BACK button on the Help menu to return to this location.

The category buttons (the buttons on the third row) provide access to the different
categories. The button labels are the category names. These buttons are used to switch from
category to category.

In addition, on the menu is a SWITCH selection. This provides an alternative means to
switch between categories. On the Switch Menu, each category label is shown plus a 25
character description of what the category contains. Also note, there are shortcut keys for
switching categories Shift F1 thru Shift F8. The categories are number from left to right, 1 to 8.

To configure the categories, under the Categories Menu Selection, choose Configure
Categories (or just click the first "blank" button or RIGHT Mouse click any category button).
This will open the Configure Categories screen. On the Config Categories screen, choose the
first blank button. Now the New box appears. In the NAME box type "testcat" (do not type the
quotes). Then Tab to the Description box and type "Test category for Tutor". Now Click the
New Button. This adds the new category, making it active (it's name will be on the button).

While the Config Categories form is active, let's load the Journal Manual so it can be
used as reference during the tutor. We'll put this on the last button. Click the last button, the
bottom one. Now look under the ADD frame, JOUMAN should appear as a category that is
present on the disk. (If it doesn't, make sure you loaded it when you installed Journal). Click
JOUMAN in the list and the ADD button (or double click JOUMAN in the listbox). Now, Click
the DONE button to return to the Journal main screen. Three buttons should now be active,
the first DAILYJOU, the second testcat and the third jouman. Red, Uppercase means the
category is loaded; black,lower case means it is not loaded. Categories that aren't loaded
aren't in the search path.

Click the jouman button, this will load the Journal Reference Manual. You can browse
some of the topics by simply clicking the title in the topic titles list. When you are done
browsing, click the DAILYJOU button to return to the first category. While you are working
through the tutorial you can always go to the Manual if you want to read a little more about the
subject. Also, this tutorial doesn't cover everything Journal does, the rest is covered in the
Manual and this Help file.



Adding New Topics

With DailyJou selected (the selected category name appears as the form title, thus when
Journal is collapsed to an icon you can always see the currently selected category). Now click
the Topics Menu.and select Daily Journal Topic. Note the shortcut for this is F4. This will add
a topic title in the format of Date, Day-of-Week,"Daily Notes" to hold your daily notes. Just
type in any text desired, but make sure the word terrific appears somewhere in the note (we are
going to use that for searching later).

Now click the New Topic button. A new topic form appears, and a prompt for the topic
title, type in as the topic title, Terrific Ideas. Topic titles can be 41 characters in length. That
title is now added to the list and the cursor moves to the topic text box. Type in any text, but
make sure the word terrific also appears in this topic text.



Read Text File into Topic

Now click the Topics Menu and select Read Text File into Topic (s) . A file dialog pops
up. Select any text file, actually any file in ASCII format, that is less than 32K in size. 32K is
the maximum text that can be stored in any one topic (If you try to load a file larger than 32K
the program will tell you and ask permission to split the file across multiple topics.). Clicking
OK in the File dialog box will read in that text file. In the File Open dialog, you can display
either just TXT files or ALL Files. (Incidently, for starters let's not bring in autoexec.bat,
config.sys, win.ini or system.ini, later on you may find Journal to be a good place to stored the
configuration files since it is easy to modify them and then saved them back to file.) The topic
title contains today's date and the file name.

When you are using this feature, remember, you can load any size text file but if it is
larger than 32K it will be split across more than one topic. Let's say you want to read in a file,
MYFILE.TXT and it is 55K in length. After selecting the file a dialog will popup asking for
permission to parse this across multiple topics. Click OK. In this case two topics will be
required. The title on the first one will be MYFILE(cont 0) and the title of the second one will be
MYFILE (cont 1).



Add New Topics From the Clipboard

With the second topic selected, on the Edit Menu select Copy All or click the CpyAl
button on the top right hand portion of the form. This puts the entire text on the Clipboard.
Make sure you DO NOT click Cut All - Del Topic as this will place all of the text on the Clipboard
but it will also Delete the Topic (if you accidently click the wrong button, answer No to the
prompt to delete the topic).

If you look carefully in the top left hand corner on your screen you should see a large
command button labeled JourClp. This button is used to put Clipboard information directly into
Journal. With the mouse in the title bar of this JourClp button, hold down the left mouse button
and drag this button down to the lower right hand corner of the screen. Journal remembers
from session to session where you have located this button.

Now click the button and a new screen appears. This screen has a place for the New
topic title, in fact the first 41 characters are presented as the default title. You can just start
typing to change the title, type some title and click OK. This will add the text as a new topic to
the currently selected category. Click here to view the Clipboard form, after you are done, click
the BACK button on the Help menu to return to this location.



Append to Topic from The Clipboard

Since we still have text on the Clipboard, click the JourClp button again. The same
screen pops up. This time, click the Append Button. A new screen appears listing the topics
currently in the selected category. The Append function is used to append Clipboard text to a
topic already in the category. Click the first topic, then click OK. This has added the text to the
first topic in the DailyJou category. CLick here to look at the Append form on the CLipboard
screen. When you are done, click the BACK button in the Help menu to return to this location.



Editing Topic Titles

Click the second topic you entered. To edit the title, Click Topics and select Edit Title,
note the shortcut key is Ctrl-T. Notice the entire topic title is highlited in the dialog box. Press
the HOME key to take the cursor to the start of the title, using the Delete key, delete the date
and click OK. This deletes the date from the Topic Title. Note: if you do not want Date
Stamping for this catgegory it can be turned off from the Categories menu.



Find Titles Search

Journal includes very powerful search routines. To get a complete overview, Click here
to read the Find Help Topic. When you are done, click the BACK button on the Help menu to
return to this location.

You may also want to view the Search Screen, Click here, to do that. When you are
done, click the BACK button on the Help menu to return to this location.

Now click the Find Menu and a new dialog appears. In the search text box type the

word terrific with no caps. Case Sensitive search should be unselected (no "x" in the box..

There are two ways to search for the word terrific: you can either search for the word in
any Topic Title in Journal , Titles Search, or you can search for the word anywhere in the text of
the currently selected category, Text Search. First select Titles Search. Since the word terrific
does appear in one of our titles, one title will appear in the titles box. The format for the data
display is first the category number (the categories are number from 1 to 8 starting from the left),
second the topic number within the category, and lastly the topic title. Clicking the topic in the
search box, no matter what category it is located in, will take you to that category and to that
topic.



Find Text Search

Now click Find Menu again and the same search re-appears containing the same data
that was previously there. Now click Text Search. New topic titles appear.

Since Text searching is done in the currently selected category, the data format is the
topic number and the title. Click on any topic takes you to that topic and to the search word. If
that word appears more than once in the topic text, pressing the F5 key will select the next
occurance of the search word in the same topic. To switch to a different Topic, click Find and
select a new topic from the list.

Now to explore the real power of these routines, double click on any word in the current
topic. Now press F6. The Search form opens and lists all topics containing the search word
anywhere in the topic titles. Click a topic and return to the main form.

Now double click another word, pick one you know will appear in two topics, for example
"terrific". Now press F7. The Search form appears listing those topics in which the search
wrod appears anywhere in the text. Click one of the topics and you are switched to the topic.

If that is not the topic you want then ctrl + S will reopen the Search form and let you select
another topic.

One last thing, on the Search form, right above the Text Search button, is a selection
option for SEARCHALL. If you check this option then the text search is done across the text of
ALL loaded categories. You should exercise a little caution in a SEARCHALL text search, if
you have a number of large categories loaded this search can take a while (hopefully not long
enough for you to write me a letter complaining about the time it is taking to do the search).

But there is a little relief - if you need to do some text search across all categories, you can first
select Config Categories from the Category Menu (or Right Mouse Click any button) and
UNLOAD those categories you don't need in the search.

The fast way to do searching is as follows:

- You want to find a word or phrase: use the keyboard shortcut ctrl + S to bring up the
Search Screen, type in the word or phrase and then click a search button (either text or titles).

- You want to see if a word or phrase in the current topic is contained in another topic.
Highlite the word or phrase (to highlite a word just double click the word) and press F7 key.
This will initiate a text search and display the results in the Search Screen.



Transfer Topics

Now select the last topic on the list. Then click the Transfer Menu. A list drops down
with the currently named categories. Select TestCat.

This action transfers the topic form the DailyJou category to the TestCat category. After
the transfer, you can delete the topic from DailyJou or leave it there. Now click the TestCat
category button to see the new topic there. When you click this button, all data in the category
DailyJou is automatically saved to disk (you do not have to click the Save Data To Disk button)
and the category TestCat is selected and displayed.

To transfer a topic to a second category, the receiving category MUST be loaded. If you
want thje topic in both categories, click NO to the prompt "Delete the topic ...".



Rearrange Topics

Click on Dailyjou to go back to that category. Click the last topic on the list. With the
mouse over the listbox, click the RIGHT mouse button. A menu appears which will allow you to
rearrange the list. Click Top on the menu. This will move that topic to the top of the list.

Whenever the Topic List box has the focus, you can use keyboard shortcuts (which is
much faster) to rearrange the list. To move the topic down one, hold down the Alt key and
press the Down arrow once. For the keyboard shortcuts to work, the topic List box must have
the focus.

If you want the list sorted, either ascending or descending, under the Category Menu,
select Sort, then either ascending or descending.



Some Additional Goodies

You can have a lot of control over how the main form looks. Click here to review the
Preferences screen. After you are done, click the BACK button on the Help menu to return to
this location.

Now under thje File Menu, select Preferences. You can select different foreground and
background colors for the listbox and the text box as well as fonts for both plus the printer. you
can also change the date format from the default, YY/MM/DD, to YY/DD/MM. Remember if you
use the format YY/DD/MM, sorting will put the topics in order by year first, days second, and
finally months last - probably not desireable in most cases.

As you enter more categories and switch back and forth, you will note that the last topic
you had displayed is the one displayed when you return to it.



Menu Commands




File Menu

Import Text File

Opens a separate form to import a file into Journal. To import the file, topics must be
delimited so Journal will know where to separate topics. Journal must also know
where to find the topic title.

Import Data File to Category

Printer Setup

Opens a separate form to set the default printer and the page margins for printing. For
page margins, you may work in either inches or millimeters.

Print Current Topic Shortcut: ctrl+P
Prints the current topic.

Print Current Category
Prints the entire category. Topic titles are printed in bold followed by the topic text.
Preferences

Used to set the font and color properties within Journal. This selection opens the
Preferences Form where you can set the font for the Titles listbox, the Topic text and
the printer. Note that the topic title listbox and the text in the topic textbox do not both
have to be the same font; using a slightly smaller font in the listbox will allow displaying
more of the title.

Daily Clip Button Visible

Determines whether the JourClIp button, for working with the Windows CLipboard, is
visible or not. If the menu selection has a checkmark, the button is visible. Journal
remebers this from session to session.

Daily CLip Button Floats

If the JourClp button is visible, then this selection will force it to continiouslt float above
all other windows. When this selection is checked, it will remain on top of all windows.
Journal remembers this from session to session.

Exit

Saves all the files and quits the program.



Edit Menu

Cut Shortcut: ctrl + X
Copy Shortcut: ctrl +C
Paste Shortcut: ctrl +V

Del

Provides standard Windows Clipboard support.

Deletes highlited text.

Strip CrLf Shortcut: ctri+2Z

Selecting this command will remove ALL CrLfs from the selected text. This is useful
when text is brought into Journal, either via Inport or the Clipboard, which has
embedded carriage return-lilne feeds. Place the mouse at the start of the text, hold
down the left button and drag over the desired text. After releasing the mouse button,
select this menu item or use the shortcut key, ctrl + Z.

Copy All Shortcut: ctrl +C

This will copy the entire text from the topic and place it on the Clipboard. No change is
made to the topic text. This function is most useful to make a copy of the topic text to
place into another document or to make a copy of a topic and place it in another
category. If copying to another topic remember the total text capacity of any individual
toppic is limited to 30K.

Cut All - Del Topic  Shortcut: ctrl + X

This will copy the entire text from the topic and place it on the Clipboard. After placing
it on the Clipboard, the topic is deleted. CAUTION should be exercised, since the
topic is deleted, the text should immediately be pasted in either another application or
another topic. This function is most useful to combine the text from two topics
together.  Select the topic you want to delete, then select COPY ALL - DEL TOPIC,
then select the topic where you want to place the text, place the cursor where the text
is to be inserted, and select PASTE to insert the text.  If copying to another topic
remember the total text capacity of any individual topic is limited to 32K.



Category Menu
These menu selections work on categories as a whole.

Config Categories.

Opens the Config Categories Form to add categories, remove categories or unload
categories. Empty buttons have the caption "blank", (YOU CANNOT USE blank AS A
CATEGORY NAME). One other precaution, the first button MUST always have a
category assigned. (You should be familiar with the terms Active and Loaded as they
relate to the categoriers.)

You can only have 8 categories active at any one time, but using this menu selection
they can be changed so quickly that you can have veritually an unlimited number of
categories. One other restriction, you cannot create two different categories with the
same name(they would have the same DOS filenames).

The shortcut to bring up the Configure Categories screen is to either click on any
"blank" button or to RIGHT MOUSE click any button.
Date Stamp Flag

When this menu item is checked, today's date is automatically appended to the start of
the topic title whenever new topics are added (whether using the New button, the
Clipboard, or importing.) This flag setting is BY CATEGORY meaning that you can set
it on for one category ond off for another. If you Sort a category, the date at the start of
the topic IS included in the sort - remember this if you use the date format YY/DD/MM.

Sort Category

This will sort a category based on the topic titles in either ascending or descending
order. The entire topic title is utilized oin the sort, thus dates will only sort correctly if
you use the format YY/MM/DD.

Rearrange Topics Shortcut: F2
Popup menu to rearrange topics. See Rearranging Topics.

Write Category to Text File

This will copy an entire category to a text file. The file will be placed in the data
directory with the filename CATEGORYNAME.TXT. The format of the file is:

Topic Title
Topic Text

*kk

Next Topic Title etc

This feature is especially useful if you want to use Journal to gather notes for a project
or paper. The notes may be easily rearranged and can be easily gathered from a
number of sources (directly typing them in, importing text files, grabbing off the



Clipboard). The topic title list serves as an outline while the text contains the
corresponding notes.



Import Text File

Open the Import Form, click here for a quick overview

This selection will import an entire text file into the currently selected Category within
Journal. You should ensure you have sufficient numbers of topics remaining to hold the
number that will be imported. Before starting the importing process you must ensure the file is
properly delimited.

Detailed Importing instructions

How to import non-delimited file

How to import a file written to disk by Journal




Detailed Importing Instructions

When getting ready to import a file you must first consider how Journal will know where
one topic starts and ends and where within that topic Journal can find the topic title. The
easiest way to examine the file is to open it with an editor. If the file is larger than 64K, you can
open it with Windows Write, just DON"T CONVERT it to Write format; leave it as a text file.
Then look at the file and see if there is a delimiter already present that marks the start an end of
topics(the delimiter must be ASCII characters - they can't be control characters). When Journal
imports a category the delimiter line IS NOT included within the topic text. If no delimiter is
present, you can add one, eg an asterisk or thre asterisks, etc.

When you open the Import form, specify this delimiter in the left hand option list. If you
want ot enter a custom delimiter, enter the delimiter in the text box before picking the third
option, Custom. In the right hand option list, you tell Journal where to find the title. It can be
the first line or the second line or you define a word which marks the beginning of the line you
wish to have Journal include as the title. If you want to use a word to define the line, enter the
word you want to use before you select the third option.



Import Non-delimited File

You will have to manually delimit the file. Journal must be able to tell where a topic
starts and ends. The line you insert to delimit the file is NOT included in the topics text after it
is imported.

The easiest way to delimit a file is to:

(1) open the file with an editor

(2) type an asterisk at the end of each topic

(3) When you bring up the import form, type a single asterisk in the Custom
input box and then select the third option for delimiting, Custom.



Import File written by Journal to Text File

If you used the Category - Export to Text File option to write the file to disk AND YOU
HAVE NOT MODIFIED the file with another editor then importing is easy: Select the first option
in each option groups:
*** (Three astericks) (Journal) for the delimiting, and
Use First Line (Journal) for topic titles

If want to transfer an entire category to another category or combine two categories, the
fastest way to do this is to write one to disk and then import the disk file into the other category.



Topics Menu

New Topic  Shortucut: ctrl +N

This functions exactly the same as the New Topic button. A title box is opened to
type in the title of the topic.  Topic titles can be up to 41 characters. The date the
topic is created is automatically appended to the start of the title (if the Date Stamp
Flag Menu selection is checked for the Category). The topic title is then added is the
topic listbox and the cursor is placed in the text box for entering the associated text.

Delete Topic Shortcut: ctrl +D

This item is utilized to remove a topic from a Journal category. It functions exactly the
same as the Delete Topic button. The topic title is removed from the listbox, the topic
text is deleted, and the remainder of topics adjusted in position (the remainder of the
topics are rolled up)

Edit Title Shortcut: ctrl+ T

This is utilized to edit the selected title. The title is presented in a dialog box. A
new title can be typed or the existed one edited. Note, the entire title text is highlited
in the dialog box presented. Typing replaces all text. If you only want to edit the title,
then you must press one of the arrow keys or click the mouse within the title to remove
the highliting.

Read text File into Topic(s)

Opens a standard Windows Open File dialog to pick a file to read into a Journal topic.
If the file is too large to fit into a single topic (max topic size is 32K), you can have
Journal parse the file into multiple topics. Each topic will have the Filename plus
"(Cont - 0), (Cont-1), etc" to indicate the files go together.

Write Topic to Text File:

This brings up the standard Windows File Save dialog to select the filename and
location. This will then write the current topic to that file.

Add Daily Notes Topic Shortcut: F4

This selection will add a topic to the current category in the format: date(either
YY/MM/DD or YY/DD/MM) DayofWeek Daily Notes. For example: 93/12/25 Mon
Daily Notes. If you leave category one configured for your daily notes, then when you
start Journal for the day, press F4 and a topic will be added for the daily notes.



Find Menu

Journal search will search all Loaded categories. If you have very large categories and you
perform text searches across all categories, it can take up to minutes to perform.

The best way to use this feature is with the keyboard. The search features of Journal provide
hypertext-like jumps for every word in the topic text. To use, in the topic text highlite the word
or phrase for which you want to search (to highlite a word just double click the word) then press
F6 to search all topic titles or F7 to search all text in all topics of the current category. (If you
want to search all text in all loaded categories you have to use the Search form and check the
SearchAll option). This will open the Search Form with a listing of all topics meeting the search
criteria. Click a topic in the list and Journal switches to that topic, making it the active topic.
The search word or phrase is highlited. If that isn't the location desired, F5 will find the next
occruance within the same topic. If it's the wrong topic, ctrl + S or the Menu Selection Find-
Search Titles/Text will reopen the Search Form and you can pick another topic.

If the word or phrase for which you want to search is not in the current topic text, then ctrl + S or
Find-Search Topic/Text will open the Search Form and you can use it for any search. You must
use the Search Form if you want to search in all text of all loaded categories.

If you have already found the search word or phrase within a topic and you want to find the next
occurance of the same search word or phrase within the topic just press F5.
Search Titles/Text Shortcut: ctrl + S

Opens the Search Form. If text is highlited in the topic textbox, it will be listed as the
default search criteria. Whenever you open the search form with ctrl + S or the menu
selection the results of the last search are still listed; this makes it easy to switch to a
different topic from the last search.

Find Next Text Shortcut: F5
Find the next occurance of the search word or phrase within the current topic.

Find Sel Text in Titles Shortcut: F6

Search all topic titles of all loaded categories and open the Search Form with all topics
meeting the search criteria listed.

Find Sel Text in Text Shortcut: F7

Search all text in all topics of the current category and open the Search Form with all
topics meeting the search criteria listed.



Switch Menu

The Switch Menu provides an alternative means of selecting categories from the
category buttons. Two features are provided:

You can attach a 25 character description to each topic. The description is shown on
both the Switch and Transfer Menus. This description can be added when you create
the category or for any existing category using the Config Categories Form.

Shortcut keys, Shift F1 - F8 are provided for switching between categories. The
category buttons are numbered from one ot eight from left to right.



Transfer Menu

This is used to transfer a topic from one category to another. To use:

1. Selected the topic you want to transfer

2. Click the Transfer Menu and select the Category to which you want the topic
transferred.

3. After the topic has been added to the new category, a dialog box askes if you want to
delete the topic from the current category - Yes will delete the topic No leaves it in both
categories.



Help Menu

Contents
Open this Help File.

Quick Start Tutorial
Opens this Help file and takes you directly to the Quick Start Tutorial.

About
Provides information on contacting the author and registration.



JourClp Button

The first time Journal is run, this button is located in the upper left corner of the screen.
It can be moved to any desired location by holding down the left mouse button over the
title and dragging the form to a new location. Journal will "remember" this location
from session to session. Only the actual command button and the title bar is
displayed.

A single click of the button performs the following:
- checks to ensure there is text on the Clipboard

- grabs the text from the Clipboard and displays the size in KBytes as the new form
title

- Opens the Clipboard form prompting for the new topic title or append topic

- Pastes the text into the topic

Text on the Clipboard can be added as a new topic or appended to an existing topic
within the currently selected category. The currently selected Category is displayed as
the form label, so even if Journal is in an icon, the text under the icon is the title of the
curently selected category.

When the Clipboard Form opens, you can type in a new title or accept the default (first
45 characters of the Clipboard), and click the OK button to add the Clipboard text as a
new topic. You can also select the Append Button to append the CLipboard Text to an
existing topic.

The JourClp button is very useful for adding information to Journal from other
programs. Simply place the text on the Clipboard, click the JourCLP button, type in
the topic title or select a topic to append to, and the Clipboard text is added. Many
programs offer shortcuts for selected all text. This makes it easy to copy the entire
text to the Clipboard. For example, in Microsoft Word for Windows, holding down the
control button and clicking in the left column will select the entire document. Then
pressing the EDIT - Copy menu selection (or the button on the toolbar) will copy the
entire text to the Clipboard. With the text on the Clipboard, click the JourCLP button.
The size of the text is displayed in the title (Journal has a maximum limit of 32K per
topic) and a dialog box pops up for the topic title. Individual application
documentation should be checked for shortcuts to copy text to the Clipboard.

Related Topic: Clipboard Form Help



Rearrange Topics

Topics can be rearranged by either Sorting, using the Category Menu - Sort Category menu
selection or manually. Sorting overrides any manual changes. Journal remembers the topic
order form session to session and if you move the category to another machine.

To manually rearrange the topics title list:
(1) Using the right mouse button,
(2) Using the Category Menu-Rearrange Topics (Shortcut is F2),
(3) Using keyboard shortcut keys.

(1) While the mouse is over the topics list cllicking the RIGHT mouse button will popup

a menu with the following choices:

Up One: moves the selected topic up one in the list

Up Five: moves selected topic up five positions

Top: moves selected topic to the top of the list

Bottom: moves selected topic to bottom of the list

Down One: moves selected topic down one

Down five: moves selected topic down five positions
To select on of the menu choices click the mouse left button over the desired choice OR using
the up-down arrow keys move the selection block to the menu item desired and press the Enter
key. if you change your mind, just clicking anywhere outside the popup menu will cancel the
menu.

(2) From the Category menu, select Rearrange Topics, Shortcut is F2, to bring up the
same popup menu. You may then either select your choice using the left mouse button or use
the arrows keys to move the highlite to the desired choice and press the enter key.

(3) While the topics list has the focus, you can use the folllowing keyboard shortcuts to
rearrange the list: (This is the fastest way)

Alt-Up: Up One

Alt-Left: Up Five

Alt-Home: top

Alt-End: Bottom

Alt-Down: Down One

Alt-Right: Down Five

When using these keyboard shortcuts, the change is instantaneous and no menu is poped up.
Remember, however, to use keyboard shortcuts, the topics list MUST have the focus. You can
transfer focus to the list box by either selecting one of the topics with the left mouse buttom or
initiate the Rearrange function using the Topics Menu-Rearrange function (Shortcut:F2).



Keyboard Shortcut Keys

ctrl+ C Edit-Copy to Clipboard
ctrl+ D Delete Topic
ctrl + N New Topic
ctrl + P Print Topic
ctrl+ R Read text File into topic
ctrl + S Open Search Form
ctrl+ T Edit Topic Title
ctrl +V Edit Paste from Clipboard
ctrl + W Write topic to file
ctrl + X Edit-Cut to Clipboard
ctrl+ Z Strip CrLf
Function keys:
F1 Open Help File
F2 Rearrange Popup Menu
F4 Add Daily Notes Topic
F5 After a text search, next occurance in same topic
F6 Search Titles for selected text
F7 Search Text for selected text

While the topics list has the focus, you can use the folllowing keyboard shortcuts to rearrange
the topics list: (This is the fastest way)

Alt-Up: Up One

Alt-Left: Up Five

Alt-Home: top

Alt-End: Bottom

Alt-Down: Down One

Alt-Right: Down Five

Right Mouse click on any category button opens the Configure Category Screen.



How To Menu

Add New Topics
Combine Two topics

Date Stamping

Delete Topics

Detailed Importing instructions
Import non-delimited file

Import a file written to disk by Journal
Import a Compuserve Message File

Rearrange topics
Use the JourClp button

Use Journal to:
Keep a daily diary/journal
Keep a Personal Information Manager (PIM)

Prepare a research paper
As a programmer's tool




Dai Iy Dia rYIJ ournal (Why is the order of the i and a different in these two words?)

The first category is idealy suited to keeping a daily diary of notes you enter on a daily
basis. Keep the first category named as DailyJou.

Each day when you start Journal, press the F4 key. This will add a topic in the format:
YY/MM/DD DAY Daily Notes, eg 93/05/08 Sat Daily notes.

Type all of your daily notes into this topic ( this might include telephone call notes,
meeting notes, new ideas, summaries of articles read during the day, etc). With a capacity of
400 topics per category you can easily keep an entire years worth in this category.

At any time you can then easily find any notes you may have previously made. For
example, you are tying in notes of a meeting you have just attended dealing with lunar cycle.
You remember an early meeting dealing with this subject. Highlite the words "lunar cycle" and
press the F7 key. The Search form opens with a listing of all topic titles that contain the phrase
"lunar cycle" in the topic text. Select the topic you want and Journal switches you to that topic
and highlites the search phrase in the topic text. Unfortunately, that's not the topic you wanted.
Press ctrl-S to bring the same Search form back up., Select another topic and Journal will
switch you to that topic and highlite the first occurance of the phrase. this is the right topic, but
you want another occurance of the search phrase within the same topic. Press F5 and Journal
will jump to the next occurance.



Personal Information Manager

Set up a seaparate category called PIM. In this category put information you want to be
able to recall. You might use keywords to help search retrivals:

IDEA for new ideas

TODO for action items etc

If you work with a particular company, add a new topic with the company name. Enter
the address, contact names, telephone numbers. Then you can quickly find either names,
phone numbers or addresses by searching for either the company name in the topic titles or the
names in the topic text.

Within the PIM category, you will frequently use the ctrl-S to bring up the Search Form
S0 you can enter the search wrod or phrase. For example, you want to find the phone
number of the sales rep at Horizon Company but you don't remember his name. Press ctrl-S to
bring up the Search form, enter Horizon as the search phrase, and press Titles Search. The
Horizon Company topic is lilsted in the the search list box. Select this topic and Journal
switches you to this topic. There is the salesr rep's name, phone number and notes you made
from the last conversation you had with him.



Research Paper

The ease of enterring data and rearranging the data makes Journal an ideal tool for
researching for a paper. Set up a category using the paper subject. Usually you will not need
to have these topics date stamped; so on the Caegories Menu, turn Date Stamping off (uncheck
it). Then within that topic add notes and ideas for the paper. You can then rearrange them
using the Rearrange functions, write the category to a text file and then import it into your
favorite wordprocessor. For example:

You are preparing a paper on "How to Select a Home Computer". Set up a category
HOMECOMP. To enter the first topic, click the NEW button. In this topic list some of the
research you want to do and where, list a rough outline of the paper, summarize the scope of
what you wnt to cover in the paper. You will use this topic to orgainze your work; when
completed you will delete this topic.

Start your research. As you collect information, store it in a new topic. During the
course of researching, you have some of your own inputs; set up a topic and enter the
information. As you proceed, you can rearrange the topics in the order you want them to
appear in the paper. Notes may be combine together and edited. When you are done with the
note collecting portion, delete the first topic and write the entire category to file. Import this file
into your favorite wordprocessor.



Programmer's Tool

As a programmer, | need to keep track of a number of different things. | put them into
separate categories. For example:

Program Code goes into PROGCODE. This enables me to keep all code listings
together. Using the search features | can quickly find a code module | have previously written
and want to reuse. | highlite the code, copy it to the Clipboard and paste it into the new
module.

| program in Visual Basic for Windows so | have a category VBNOTES for holding notes
on Visual Basic. A lot of these notes come from various forums on Compuserve, tips from
magazines, etc.

Since | frequent Compuserve and use the TAPCIS program, | have a category CISTAP
to hold general information about Compuserve and Tapcis. For example, Tapcis issues a
monthly newsletter which | keep in CISTAP.

| am a member of the Association of Shareware Professionals so | have another
category, ASP. In this category | put notes from the ASP Forum on Compuserve, text files
distributed by ASP, etc.

To write the documentation for this program, | started with a category called JOUHELP.
| added new topics for each subject and wrote the text for each item.



Compuserve Message File Import

To import a Compuserve message file, you will have to use a custom dellimiter.
Remember, the line you use as the delimiter will not be imported. You can open the entire file
with a text editor and insert a delimiter, or use the #: which starts each message, as the
delimiter. This example will use the latter method.

Compuserve message files can get quite large and contain a lot of messages. Journal
can hold up to 400 topics and each message will be imported as a separate topic. You do want
to ensure you have enough topics remaining to hold the message file.

- Click File Menu - Import File to open the file import form

- In the Text Delimiters frame, the Custom textbox type "#:" (do not include the
quotes), and then click the Custom button

- In the Topic Title Line frame, in the textbox under Use line Starting with, type "Sb:" (do
not include the quotes) and then click the option Use Line Starting with. This selection will
bring the Compserve Message Subject in as the Topic Title.

- Click the Select Flle button to open a standard Windows File Open dialog box. In the
lower left portion of the dialog box, List Files of Type dropdown listbox, select All Files (*.).
Then switch to the directory containing the Compuserve Message file you want to import (file
extent is msg) and click OK.

- This will return you to the Journal Import form. Click the Import button to import the
file.

After importing the message you can then combine some to group like topics and delete
those you do not want to keep. One method is to use a separate Category, called CISMSGS
for importing and then transfer topics to other categories after you have imported the file and
grouped, edited and deleted.



Add New Topics

New topics can be added in any of three ways:

(1) Typing directly into Journal
a. CLick the New Button, select New Topic from the topics menu, or press ctrl-N.

b. This will bring up a prompt for the title of the topic. You can type up to 41
characters for the title.

c. The cursor is then placed in the text box where you can type in up to 32K
characters.

(2) Grab the Clipboard text

a. Click the JourCLP button. This will grab the text currently on the Clipboard and
open a new form.

b. The new form will allow you to either add the text to the currently selected
category as a new topic or to append the text to an existing topic. The form opens in
the add new topic mode.

c. To add the text as a new topic

- You can either type a new title into the title box or accept the defulat. By
default journal enters the first 41 characters of the text from the Clipboard as the
default title. Once the title is set, click the OK button to add the topic.

d. To append the text to an existing topic, remember a topic may only contain 32K and
journal will check to ensure you do not exceed this limit, click the Append Button. This will
change the form to the append mode. In this mode, all of the topics in the currently selected
category are shown in a list box.

- Select the title of the topic to which you want to append the text
- Click the OK button to append the text.

(3) Read a Text File into a topic

When reading a text file into a topic, if the file is too large, exceeds 32K, journal will ask
if you want ot parse this file across multiple topics. Normally this is what you would
want to do. When you click yes, Journal reads the file into a topic and assigns as the
topic title the filename. If the file is parse into multiple topics then the title is on the
format: filename (cont 0 ), filename (cont 1), etc.

To read in afile:

- Select menu Topics-Read Text File into Topic(s) ... SHORTCUT: ctrl-R

- This will open a standard Windows File Open dialog to select the file. After the
first selection, Journal remembers the directory where you got the last file and returns

to that directory, as the default.

- Select the file and click OK.



- If thefile is larger than 32K, journal will prompt to parse the file across multiple
topics. Normally just click OK. The one time you would not want to do this was if you
need to edit the file. Then since the file is too large to fit into a single topic, you will
need to use another tool to edit the file.



Date Stamping Topics

Under the Categories Menu, if Date Stamp Flag is checked (default selection), then
today's date will automatically be added to the start of the title. Date Stamping can be turned
on and off via the Category-Date Stamp Flag selection; when it is check, date stamping is on.
Date Stamping is set by category which means you can have it on for some and off for others.



Delete Topics
Select the topic you want to delete by clicking on the title in the list box. Then:
(1) Click the Delete Topic button, or
(2) Select Topics Menu-Delete Topic, or
(3) Press ctrl-D. Once deleted, the topic cannot be retrieved.

As a note, when you transfer a topic from one category to another, it
can be deleted from the category from which you are transferring the topic.

If you have several topics to delete and they are all together:
- Select the last topic in the list to delete
- Click the Del Button
- Then just keep pressing the ENTER key on the keyboard until you have
deleted the last topic.



Combine Two Topics

To combine two topics,

- first select the topic you want to remove.

- Then select Edit-Cut All-Del Topic or click the CutAll button. This will place
the entire topic text on the Clipboard and delete the topic.

- Next select the topic to which you want to add the old topic text. (This does
not have to be in the same category.)

- Within the new topic place the cursor where you want the text added and
Select Edit-Paste or click the Paste button.

You can also use this feature to delete a topic and use the text in another application.
For example, is you have been using Journal to collect notes which you want to use in another
paper being prepared in a Windows wordprocessor. Then within Journal select the first topic
you want to move to the wordprocessor, select Edit-Cut All-Del Topic. Then switch to the
wordprocessor and PASTE the text in place where you want it. Then return to Journal and get
the next topic.

You can do the same function with Edit-Copy All if you DO NOT want to delete the topic
from Journal.



About

HandyWare

2233 Lovedale Lane Apt |
Reston, VA 22091
703-715-9037

Author

Gordon Smith
CompuServe 72567,3416

For technical support:
Call 703-715-9037 or Compuserve 72567,3416.



How to Register Journal
The price of Journal is $39.00 (US). You can register the program by sending $39.00 to:
HandyWare

2233 Lovedale Lane Apt|
Reston VA 22091

CREDIT CARD ORDERS ONLY -

You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling 800-
2424-PsL or 713-524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470. You can
also mail credit card orders to PsL at P.O.Box 35705, Houston, TX 77235-5705.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.
Any questions about the status of the shipment of the order, refunds, registration options,

product details, technical support, volume discounts, dealer pricing, site licenses, etc, must be
directed to 703-715-9037.

The full version of the program is distributed in shareware with no crippling and no
reminder screens. If you already have received the program, from a BBS or vendor, check for
a file PACKING.LST. If you did not receive this file, report to HAndyWare. If you did and you
have all of the files in the list, then you have the full program and no disk has to be mailed.
Once registered, if the version you are registering is not the latest version, it will automatically
be mailed to you without cost or specific request.

If you do not have a copy of the program, you can obtain it from HandyWare at the
address at the top of this topic. Shipping and handling costs for Us and Canada are $4.00 and
overseas is $6.00

Benefits of Registering:

- You will own a legal copy. Using the program past the thirty day evaluation period,
without registering, is illegal.

- You will assist in keeping the program updated and in adding new features to the
program in the future.

- Your comments for changes or improvements will receive priority consideration. For
example, the version 3.0 upgrade addressed every user comment to date (there are cases
where user desires conflict. In these cases HandyWare makes the decision on what to
incorporate).



ASP

JOURNAL is produced by a member of the Association
of Shareware Professionals (ASP). ASP wants to make sure
that the shareware principle works for you. If you are
unable to resolve a shareware-related problem with an ASP
member by contacting the member directly, ASP may be able
to help. The ASP Ombudsman can help you resolve a dispute
or problem with an ASP member, but does not provide
technical support for members' products. Please write to
the ASP Ombudsman at 545 Grover Road, Muskegon, Ml 49442-
9427 or send a Compuserve message via CompuServe Mail to
ASP Ombudsman 70007,3536



Shareware
DEFINITION OF SHAREWARE

Shareware distribution gives users a chance to try software
before buying it. If you try a Shareware program and continue
using it, you are expected to register. Individual programs
differ on details -- some request registration while others
require it, some specify a maximum trial period. With
registration, you get anything from the simple right to continue
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software,
and the copyright holder retains all rights, with a few specific
exceptions as stated below. Shareware authors are accomplished
programmers, just like commercial authors, and the programs are
of comparable quality. (In both cases, there are good programs
and bad ones!) The main difference is in the method of
distribution. The author specifically grants the right to copy

and distribute the software, either to all and sundry or to a
specific group. For example, some authors require written
permission before a commercial disk vendor may copy their
Shareware.

Shareware is a distribution method, not a type of software. You
should find software that suits your needs and pocketbook,

whether it's commercial or Shareware. The Shareware system makes
fitting your needs easier, because you can try before you buy.

And because the overhead is low, prices are low also. Shareware
has the ultimate money-back guarantee -- if you don't use the
product, you don't pay for it.

DISCLAIMER - AGREEMENT

Users of JOURNAL must accept this disclaimer of warranty:
""PROGRAM is supplied as is. The author disclaims all
warranties, expressed or implied, including, without limitation,
the warranties of merchantability and of fithess for any purpose.
The author assumes no liability for damages, direct or conse-
quential, which may result from the use of JOURNAL."

JOURNAL is a "shareware program" and is provided at no charge
to the user for evaluation. Feel free to share it with your

friends, but please do not give it away altered or as part of
another system. The essence of "user-supported" software is to
provide personal computer users with quality software without
high prices, and yet to provide incentive for programmers to



continue to develop new products. If you find this program
useful and find that you are using JOURNAL and continue to use
JOURNAL after a reasonable trial period, you must make a reg-
istration payment of $39.00 to HandyWare. The $39.00
registration fee will license one copy for use on any one
computer at any one time. You must treat this software just like
a book. An example is that this software may be used by any
number of people and may be freely moved from one computer
location to another, so long as there is no possibility of it

being used at one location while it's being used at another.

Just as a book cannot be read by two different persons at the
same time.

Commercial users of JOURNAL must register and pay for their
copies of JOURNAL within 30 days of first use or their license

is withdrawn. Site-License arrangements may be made by con-
tacting HandyWare.

Anyone distributing JOURNAL for any kind of remuneration must

first contact HandyWare at the address below for authorization.

This authorization will be automatically granted to distributors
recognized by the (ASP) as adhering to its guidelines for

shareware distributors, and such distributors may begin offering
JOURNAL immediately (However HandyWare must still be advised so
that the distributor can be kept up-to-date with the latest

version of JOURNAL.).

You are encouraged to pass a copy of JOURNAL along to your
friends for evaluation. Please encourage them to register their
copy if they find that they can use it. All registered users

will receive a copy of the latest version of the JOURNAL
system.



Questions and Answers

Every time | start Journal, | get the same prompt asking me if it's the first time | have run the
program?

If | change the date format, will all dates in existing topics change to the new format?

If fewer categories are loaded. do | use less memory?

| notice it takes considerably longer to switch between some topics?

What should | do if | discover something that appears not to be working correctly?
Author

Why did you have to change file format?

Is support available during the evaluation period?

What does "Bad Data Set" mean?
Why is part of the bottom of the scroll bar in the ltitles listbox hidden?
How can | put a Microsoft Word document into Journal?




File Menu: The file menu is utilized to import ACSII files, set Journal preferences and
printing.

Import File: Pops up a dialog box prompting for the file you wish to import. This file MUST
be delimited so Journal will know where to break topics.

Printer Setup: Set Default printer and page margins

Print Current Topic: Prints the current topic

Print Current Category: This prints the entire currently selected category with one topic per
page

Preferences: opens the form for setting preferences

Daily Clip Button Visible: When this item is checked the JourCLp button is visible for
grabbing text off the Clipboard.

Daily Clip Button Floats: When this is checked the JourCLp button will float on top all other
windows.

Exit: Quits the program saving all files



Edit Menu: Cut, Copy, Paste, and Delete are standard windows commands. In addition:
Strip CrLf: causes a hand to reach out from the computer and rips your clothes off.  OF, strips CrLfs from the
selected text.

Copy All: Copies the current topic to the Clipboard

Cut All:  Copies the current topic to the Clipboard and then deletes the topic.



Category Menu: Used to control the categories.

Config Categories: opens the Config Categories form.

Date Stamp Flag: Turns the date stamp for topics on (if checked) for the category. This will
insert today's date in each topic added.

Sort Category: Allows sorting a category in either ascending or descending order. If dates
are used at the start of the topic, dates are part of the sort criteria.

Rearrange Topics: Pop ups the Rerrange Menu

Write Categoruy to Text File: This will write the current category to a text file. This file will
have each topic delimited with "***" and place the topic title on the first line.



Topics: This menu is utilized to manage the currently selected topic

NewTopic: Adds a new topic

Delete Topic: Deletes topic

Edit Title: Edit the topic title

Read Text File into Topic(s): reads the selected text file into a topic. If the text file is too
big for a single topic (>32K), it will prompt to read the text file into multiple topics.

Write Topic to Text File: Opens a dialog to specify where to save the file

Add Daily Notes Topic: Adds a topic especially setup for a daily notes journal



Find: Use to find words in either the titles or text. Only the currently LOADED categories
are searched.

Search Titles/Text: Brings up a separate search dialog.

Find Next Text: After a search, this will find the next occurance of the search word in the
current topic.

Find Sel Text in Titles: First select a word or phrase within the current topic text. This menu
selection, note the shortcut key F6, will search for this word or phrase in all the topic titles of
LOADED categories.

Find Sel Text in Text: First select a word or phrase in the current topic text. Then this menu
selection, note the shortcut key F7, will search for this word or phrase throughout the entire
category text.

Note: The only way to do a search for a word or phrase throughout the text of all loaded
categories is to use the search dialog form, the first menu selection or Ctrl + S.



Switch: This duplicates the category buttons with a couple added features. The category
description is also shown on the menu. Shortcut keys are also established with the
categories number 1 to 8 from left to right.



Transfer: The transfer menu is utilized to move a topic from one category to another. The
topic can be deleted from the old category, if desired.



Help:
Contents: Brings up this file.
Quick Start Tutorial: Runs the Help Flle quick start tutorial.



Category Buttons: Clicking one of these buttons switches between categories. If the
category is not loaded, it will be loaded. Note: Loaded categories are shown with captions
in all caps and Red. If you click on a "blank" category button, the Configure Categories form
will appear so you may add a category to that button. After adding the Category, Journal
will switch to that category.

If you click the RIGHT mouse button over any category button, the Configure
Categories form will appear. If you Remove or Unload the currently selected category,
journal will take the requested action and switch you back to the first category.



NumofTopics: Displays the numbers of topics in the current category is shown.
Size label: Displays the size of the current topic. This is only updated when you actually
are switching topics.



New: Click this button to add a new topic. A new Topic form will appear. New topic titles
max length is 41 characters.



Del: This will delete the currently selected topic.



Save: this will save everything, including the current screen layouts. This button is really
only necessary when you are typing a lot of text in the same topic and you want to
periodically save the text.



Edit buttons: Standard Windows Copy, Cut and Paste functions.



Strip CrLf: Strips CrLf from selected text.



Copy All: The will copy the entire text of the current topic to the CLipboard.



Cut All: This will copy the text of the current topic to the Clipboard and then prompt to
delete the topic.



Topic Titles: Click the topic desired.



Topic Text box. Normal Windows edit box displaying the current topic text.



Form Caption: Displays the name of the currently selected category. This name shows
under the icon when it is minimized.



Category Options: Click the button for the Category to change.



Change Desc: To change a category description, type a new description in the change
textbox.



Change Desc: To change a category description, type a new description in the change
textbox.



Remove: Click this button to remove a category from one of the buttons. This will make
the category inactive.



Unload: To unload a category click this button. The main reason you would want to unload
a category is to take it out of the search path. This could be important if you are going to
search text in all loaded categories; this permits unloading a category wherein you do not
want to search. To reload the category, just click the category button on the main form.
Unloaded categories have small, black letters as captions.



Done: Action complete, return to main form.



New: To add a new category, type a legal DOS filename in the Name textbox and click the
New Button.



New Textbox: The NAME box is where you type the name of a new category you wish to
create. The name must be a legal filename.



New Description: Type in a description for new categories BEFORE you click the new button.
If you already clicked the New button, you can change the description using the Change
description button.



Add Button: ADds the category selected in the Category listbox to the selected category
button.



Add Listbox: Used to select the category you want to add. This makes the category active.



SearchText: Enter here the search word or phrase desired. If you invoke a search with text
highlited in the topic textbox, that text is automatically placed in the search textbox.



Case Sensitive: When this option is checked, the search is case sensitive. Case sensitive
search take slightly longer to perform.



Found: After a search this label indicates the number of topics found. If the caption reads
"Max" then more than 50 topics were found to meet the criteria; you may need to redo the
search with a more restrictive search criteria.



Titles Search: This button will search for the search phrase in the titles of all loaded
categories.



Search All:  When this option is checked, a text search will search for the search phrase in
the text of all categories loaded. Depending on the total size of all loaded categories, this
search could take a while to perform.



Text Search: This button executes a search for the search phrase in either all the text of the
current category or all the text of all loaded categories. The Search All option decides
which.



Next Text: Searches for the next occurance of the search phrase in the current topic. This
function is normally performed using the shortcut key, F5, while in the topic text.



Search List: This listbox contins the results of a search. The first digit is the category; the
categories are number 1 to 8 from left to right. The second digit is the number of the topic
in the category. This number is only meant to provide a relative estimate of where in the
list the topic is located. Finally, the topic titles are listed. To go to any topic, just click the
title. When the title is clicked, the topic is selected and the search phrase highlited.



Active: A category is Active when it is assigned to one of the eight category buttons. An
Active category may be loaded by simply clicking the category button.

A category may be:

Not Active: Itis on the disk and in the default directory but it is not assigned to any
of the buttons. To make the category active, use the Config Categories menu selection and
ADD it to one of the buttons. To make an Active category inactive, use the Config
Categories Menu and REMOVE the category.

Active, but not loaded: It is assigned to one of the buttons, it's caption is in all
lower case letters, it's assignment to a button will be saved from session to session, can be
openned by just clicking the button to which it is assigned (or using the Switch Menu or
Switch Menu shortcut) but it is NOT included in a search path.

Active and Loaded: It is assighed to one of the buttons, it's caption is in all upper
case letters, it's assignment to a button will be saved from session to session, has been
openned because it's button has been clicked and it IS included in the search path. To
Unload a category but keep it active( you would do this because you do not want the
category included in the search path) use the Config Categories Menu and UNLOAD the
category.



Loaded: When a category is loaded it's caption is in all captial letters and it is included in
the search path. To load a category, click the category button. To unload a category, use
the Configure Categories menu and Unload a category.

A category may be:

Not Active: Itis on the disk and in the default directory but it is not assigned to any
of the buttons. To make the category active, use the Config Categories menu selection and
ADD it to one of the buttons. To make an Active category inactive, use the Config
Categories Menu and REMOVE the category.

Active, but not loaded: It is assigned to one of the buttons, it's caption is in all
lower case letters, it's assignment to a button will be saved from session to session, can be
openned by just clicking the button to which it is assigned (or using the Switch Menu or
Switch Menu shortcut) but it is NOT included in a search path.

Active and Loaded: Itis assigned to one of the buttons, it's caption is in all upper
case letters, it's assignment to a button will be saved from session to session, has been
openned because it's button has been clicked and it IS included in the search path. To
Unload a category but keep it active( you would do this because you do not want the
category included in the search path) use the Config Categories Menu and UNLOAD the
category.



Listbox Font Labels: The current font and color selections for the titles listbox. As you
change color selections they are reflected in these labels.



Change: Click this button to bring up a font dialog to change the titles listbox fonts.
Making this font smaller shows more of the text in the title box.



Forecolor: Click the desired option button for the foreground color desired.



Backcolor: Click the desired option button for the titles box background color.



Textbox labels: Show the currently selected fonts in the current foreground and background
colors.



Change: To change the topic textbox font; this brings up a standard windows font selection
dialog.



Forecolor: Click the desired option button for the topic textbox foreground color. The
selection is reflected in the textbox labels.



Backcolor: Click the desired option button for the topic textbox background color.



Printer: The labels show the currently selected font. Click the Change Button to bring up a
standard windows dialog box to change these fonts.



Date Format: Select either MM/DD or DD/MM for the date stamp format. IMPORTANT: In
sorting, the dates are included in the sorts. Date sorting will only be performed
correctly if you use the MM/DD format.



Cancel: CAncels the action and closes the form.



New Topic Name: This is the topic title that will be used for the new topic added from the
Clipboard. By default, the first 41 characters from the CLipboard are enterred as a title.



OK: Add the Clipboard as a new topic to the currently selected category.



Append: If you want to append the Clipboard to an existing topic, click this button to bring
up the append form.



Append List: This is a listing of the topics in the current category. Highlite the topic to
which you want to append the CLipboard and click the OK button.



OK: Appends the Clipboard to the currently selected topic.



New Topic: If you change your mind about appending, this will return you to the New topic
screen allowing you to add the CLipboard as a new topic.



Every time I start Journal, I get the same prompt asking me if it's the first time |
have run the program? - You must specify the working directory fir Journal so it can find
the data files. The INI file is located in the working directory.

If you are using the Program Manager then select the Journal icon in the group.
Then click the Files menu - Properties selection. Set the working directory to where you are
stroing your data files.

If you are using Norton Desktop, the working directory is set in the same manner
except you have to go to the Advanced Options to find the working directory setup.



If I change the date format, will all dates in existing topics change to the new
format? - No - but all new topics added will have the new date format. You will have to use
the Edit Title (Topics Menu or ctrl + T as a shortcut, to edit existing topic titles.



I notice it takes considerably longer to switch between some topics? - Each time
you switch topics, the old topic is saved to disk and the new one loaded from disk. If you
want faster switching keep your topics smaller.



What should I do if I discover something that appears not to be working correctly?
- (The actual question was what do | do if | find a bug - but we don't like "bugs". ) Report it
to the author. All questions or problem reports are requested and appreciated!!



Why did you have to change file format? - The new file format is much more robust
than the old format utilized. Under the old format, if any of the files were damaged you
could loose all of the data. Also, under the old format we were unable to do a couple simple
things like sort the data. We are, infact, investigating a number of other improvements

possible under this new format - depends on user input.



Is support available during the evaluation period? - Full support is provided during the
evaluation period. Otherwise, you might not be able to

fully evaluate the product. Only you know if your evaluation period has exceeded the 30
days we provide.



If fewer categories are loaded, do I use less memory? - Essentially no; you will use a
few KB less since the Topic Titles won't be stored in memory.

But even if the category were full, 400 topics, you would only save about 20 KB. Only the
currently selected topic text is stored in memory.



This will allow you to import an existing data file into Journal. It is important that Journal
know how to delimit the topics within the data file. If you are not sure about the data file,
you may want to view it in an editor before trying to import.



Use this selection if the topics are delimiter by three astericks. This is the way Journal
delimits the topics when writing to a text file.



Use this option if you have manually edited the file and used the word "End" as the topic
delimiter. This is case sensitive.



Pick this option if the text file already has an ASCII delimiter. You can specify any ASCII
string.



After reading in a topic, Journal has to know where to find the title to add to the Title List
box. These options allow yoou to specify either the first or second line.



Use this option when the title line always starts with the same string.



After selecting the file, the filename including path is shown.



Opens this Help file



Use this button to open a standard Windows dialog to locate the file you want to import.



This starts the actual importing. If you are importing a large file this could take a few
minutes.



Cancels the action.



Rename: Select a category name from the AddListBox and then click this button to rename the
category. To use this function, you must first Remove the category from Journal. It will then appear in
the AddListBox. The rename screen pops-up in place of the Add New Category frame. this function will
rename all four category files.



Kill:  This will completely delete a category from disk. To use this function, you must first Remove the
category from journal. Then select the category from the Add List box and clilck the Kill button. A
prompt will appear to be sure you want to delete the category. This will delete all four category files.



What does "Bad Data Set" mean? - You should not see this error message - it means a data file may be
corrupted. You should report this to the author including a description of what you were doing in the
category. You can try to delete the .LST file. Journal will then try to rebuild the topics file from scratch.



Why is part of the bottom of the scroll bar in the ltitles listbox hidden? - To correct this, resize the overall
Journal main window slightly and it should correct.



How can I put a Microsoft Word document into Journal? - If the document is less than 32K there are two
ways: (1) From within Word, select Edit-Select All and copy the document to the Clipboard. Then click
the JourClp button to grabn what is on the Clipboard and insert in Journal. (2) From within Word, save

the document as a text file and then within Journal use the Topics-Read File into ... to read the file into
Journal.

If the file is larger than 32K, then you will have to save the file as a text file and use from Journal
the Topics - Read File ... menu to bring it into Journal since this file is too large for a single topic.
Using either method will loose all formatting from within Word.









